
THE BARCODE EXPERTS

Church Road, Weston on the Green, Oxfordshire, OX25 3QP, UK
Tel: +44 (0)1869 351155 | Email: sales@axicon.com

Web: www.axicon.com

user guide

Axicon 15000
2D-linear barcode verifier

Industry 
Partner



Contents

Introduction 5

How the verifier works 6

Getting started 7

Calibration 10

Operating the verifier 11

Settings 13

2D matrix codes 18

Several barcodes in field of view 19

Saving and printing 20

Disclaimer 21

Software licence agreement 22

Warranty 24

Service contract 25

Factory re-calibration 26

Certificate of conformance 27

Contact us 28

Page 2 of 28 Page 3 of 28

Axicon Auto ID Limited  |  15000 verifier user guide | March 2016 Axicon Auto ID Limited  |  15000 verifier user guide | March 2016

www.axicon.comwww.axicon.com



Introduction
The Axicon 15000 is designed to work with any PC running a currently supported 
version of Windows (Windows 7, Windows 8, Windows 10 – both 32 bit and 64 bit 
versions). 

Specification and application
This verifier can be used to verify barcodes with a size of up to 51mm x 31mm. 
These will usually be barcodes used on retail point of sale or healthcare items. 
ITF-14 and GS1-128 barcodes will typically be too large to be read by this verifier.

Linear barcodes: EAN-8, EAN-13, UPC-A, UPC-E, Code 39, Code 93, Code 128, 
Codeabar, ITF, MSI Plessey.

2D barcodes: GS1 Data Matrix, GS1 QR codes

Other: OCR human readable characters for EAN/UPC barcodes can be matched to 
the barcode number

Application standards: Data content checking can be performed for GS1 DataMatrix 
or GS1 QR Codes that encode GS1 Application Identifiers.

Multiple barcodes within the field of view will be found and can be verified to the 
appropriate standards.

What is in the case.
• Axicon 15000 Series verifier
• Software CD 
• Wallet containing this user guide and the calibration card.

System requirements 
• Currently supported Windows Operating System (either 32 or 64 bit)
• 12 MB disc space
• 512 MB RAM minimum
• USB 2.0 port

Software Installation
Insert the CD into an appropriate drive and the Install program should start 
automatically. If it does not, run Setup.exe. When the software has been 
successfully installed, leave the CD in the drive, so that the USB driver will be 
installed when the verifier is connected to the computer.

Hardware installation 
Connect the USB lead from the verifier to a USB2 port on the computer. Please 
install the software before connecting the 15000 verifier. 
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How the verifier works
The verification begins with capturing an image which includes one or more 
barcodes. Having captured this image, the verifier is then asked to decode any 
barcodes it can find in the image. This is a two stage process, which is started by 
clicking on the green arrow icon (or pressing one of the buttons on the verifier) to 
start the image capture, and then by clicking on the decode command icon (the two 
turning arrows) or by pressing one of the buttons a second time.

The image that has been captured and decoded can be saved as a .png file, and 
this can be re-verified at any later time. This is useful when the image contains 
more than one barcode. The software allows the creation of verification reports for 
each barcode that appears in the image, and the user simply clicks on the relevant 
barcode for which a report is required.

More details about this process, saving image files, and saving verification reports 
are explained later on in this user guide.

The file menu and the icons
The top left of the Axicon Camera Verifier window includes the menu bar with five 
options, and the toolbar which includes seven command icons.

The File dropdown menu includes options for saving, load scan (open), appending 
and printing verification reports.

The Edit dropdown menu provides options for cutting, copying and pasting.

Getting started
The home window for the software is shown below, and this will appear when the 
software is launched. The window has four main areas, and these are explained 
below.

Double-click on the Axicon Camera Verifier icon. The first window will open, and the 
software will check if the verifier is connected. If a verifier is not connected, the 
message Found Readers 0 will appear in the status bar. It will then be possible to 
load (to open) previously saved verification reports. When a verifier is connected, 
the message here will provide the verifier’s serial number.
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This panel has three tabs, where the first set 
of information about the barcode is shown. 
The General tab will show you the decoded 
data from the symbol, its x and y dimensions, 
the print gain, and the aperture size.

The Reader tab simply gives you detailed 
information about the verifier such as its 
serial number and build version.

The Scan tab provides details of when the image to be verified was scanned by the 
verifier.

Getting started

The Details tab provides a summary of the results of 
the verification.

The ISO tab will include details of all the separate 
parameters defined by ISO/IEC for the particular 
barcode being verified.

The bottom left panel will include details that relate to the analysis of a symbol by 
one or more of the optional plugins. Plugins are briefly explained later on.

The status bar is at the very bottom of the window, and provides details of what the 
verifier is doing.

The View dropdown menu gives access to Settings (F5) and User data.

The Reader menu provides options for choosing which verifier is operational, reader 
information,Scanning, decoding, and calibrating the reader (the verifier).

The Help menu provides access to the Axicon website, a check for software 
updates, and information about the software.

The Command icons

Quit the application, or use Ctrl + Q

Load a saved barcode image, or use Ctrl +O

Save the current image and verification report, or use Ctrl + S

Start collecting barcode images in the field of view, or press one of the two 
buttons on the verifier. (They both do the same thing, so use whichever one is 
more convenient.)

Find and decode the barcodes seen in the field of view.

Edit the settings for the application, or use F5

Display and edit user-defined data for this scan.
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Users must calibrate the verifier on a regular basis to ensure that its measurements 
are equivalent to reference values. The calibration card supplied with the verifier 
provides barcodes with known maximum and minimum reflectance values. The 
calibration card is certified for a minimum of one year (unless it has been physically 
damaged).

When it is not being used please keep the card flat in its plastic envelope, and away 
from direct sunlight. If the card shows any sign of damage – for example, scratches 
or any change in colour – please obtain a new card from us before proceeding.

Take the card from the plastic wallet, and place on a flat surface. Place the verifier 
over the EAN-13 barcode at the top left hand side of card so that it appears in the 
Axicon Camera verifier window as shown below. Start the image capture process 
by clicking on the green arrow icon. This will change to the pause button icon while 
this is taking place.

Calibration

Then select Reader, and from the pull-down menu select Calibrate. The verifier 
will ask the user to confirm positioning and confirm that the RMax and RMin figures 
shown on the window conform to those printed on the card. If they are different, 
alter the numbers on the window as required and then press Start.

The verifier software will then check the image before calibrating the instrument 
and then rechecking. When this has been done a message Calibration Successful 
will be shown and the verifier is ready for use.

Activate the verifier by pressing the green Start Scanning 
arrow, or press one of the buttons on the verifier (Both 
buttons perform the same functions). Then place the verifier 
over the barcode(s). The message Scanning will appear at the 

bottom of the window.

Press the Search/verify button to search for 
all barcodes within the current field of view 
or alternatively press one of the buttons on 
the verifier (both buttons perform the same 
function).

The verifier will draw a purple box around each 
of barcodes it has found, and automatically 
select the first barcode to decode. It will 
change the colour of the box around this one to 
blue and display the verification results.

When only one symbol is present the box will be blue, and if it is 
an EAN/UPC barcode a purple box will appear around the numbers 

shown below it.

Operating the verifier
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Settings
The verifier has a range of configuration settings. These can be set by clicking on 
View and then selecting Settings.

Appearance: The Appearance tab allows you to change the colours used for Fail, 
Warning and Pass, choose the language and switch between metric or imperial units 
of measurement.

Plugins: The Plugins tab can be used to select data content checking to any of the 
various standards shown.

Any linear barcode will be verified using ten different scan lines, as specified by 
ISO/IEC 15416, and the verification grade will be based on the average of these ten 
readings.

In this case the verifier has responded with the message Found codes: 1 and 
has found both the EAN-13 barcode and the numbers (the Human Readable 
Interpretation) beneath the barcode.

The verifier will automatically display the overall verification result based on the 
average of ten scans made of the barcode.

To get more information about the grading of any of the particular parameters you 
can click on the relevant parameter.

The verifier will then indicate where the scan lines were taken and (if relevant) 
which scans were a pass for that parameter (shown in green) and which scan lines 
were a fail (shown in red).

To get a scan reflectance profile of your linear barcode you can click on the Details 
tab and select any of the Scan Info rows available. The reflectance profile will now 
show at the bottom of the scan info results. Click on the reflectance profile to 
enlarge it.

Operating the verifier
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Settings

Reports: In this window you can enable Auto Save, select the type of report file 
to be created, and choose an output file where the data will be kept. There is an 
option to add the records to an existing file rather than replacing the file, which is 
mainly of benefit with spreadsheet (.csv) files. 

Saving: The Saving tab can be used to enable an Autosave of all of the barcodes 
checked for audit purposes. The options are as follows:

Autosave – records will be automatically saved to provide a complete audit trail of 
verifications performed. The Autosave Directory name should be set by the user. 

If Enable is ticked on and a directory specified but all other boxes remain unticked 
then the verifier software will create sequentially numbered files of the saved data. 
This will ensure that records cannot be inserted, deleted or modified without it 
being apparent (essential for compliance with 21 CFR Part 11 requirements).

If Use Decode box is ticked, the file name will automatically be created using the 
first digits of the decoded number.

If Use Date and Time box is ticked, the file name will automatically be created 
using the date followed by the time as a file name.

If Use Decode and Use Date and Time boxes are both ticked, the file name will 
automatically be created using the decoded number followed by the date and time.

If Save as box is ticked, a dialogue box will appear and you can enter a filename.

If Auto Save as box is ticked in addition to Use Decode or Use Date & Time (or 
both), then the dialogue box will appear with the pre-selected data and allow the 
operator to override this if required.
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Settings

User data: User Data allows you to program the Axicon 15000 software to ask 
questions when a verification is being made, to collect the answers and to store 
these with the verification report. This supplementary user date will then always be 
displayed with the verification report.

Such data may typically be a job reference number or batch number, but equally 
it could be information about the barcode such as the substrate or print process or 
details about the operator, the department or the site. Multiple questions can be 
entered if desired.

To set up the User-Data:
From the pull-down menu select View and then Settings. Click on the User Data 
tab of the Settings window. To add a User Data item press the + symbol at the 
bottom left of the window. The Create User Datum window will be shown. This can 
now be completed as required.

An example of a Job Reference entry is shown 
here. The title is entered and the Allow Blank is 
un-ticked to force you to enter data into this field.

This sample shows how you can be offered a 
pull-down menu of options but with a default 
option given. The default can be left blank. When 
the list of selected questions has been completed 
press the OK button.

Now when you verify a barcode and select save 
scan the User Data dialogue window will appear 
and allow you to enter the required information. 
If you now save the scan file the User Data 
information is automatically saved with it.

When loading a pre-saved scan file for which User 
Data has been attached you simply need to load the 
scan file, and re-verify the code using the Search 
for all barcodes icon and then select View/User-
Data from the pull-down menu.

The Axicon software also includes a facility for 
populating the User data settings screen from 
an existing scan file (whether made from this 
computer or not). Simply load an existing scan file, 
go to the View/settings/User Data screen and then 
press the populate icon.

There are also facilities to edit an existing User 
Data entry (ideal for adding items to a pull-down 
menu). You can also clear an existing User Data 
population.
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After you have activated the verifier and set it to search/verify for any barcodes, 
the result of verifying a GS1 DataMatrix symbol will appear like this window:

 

By clicking on the individual parameter the reason for any data content error is 
displayed

If required the Data Content box can be stretched vertically to show more 
information – just hover over the top edge of the box until the double horizontal 
lines appear and then stretch the box.

2D matrix codes Several barcodes in field of view
In cases where there are multiple barcodes within the field of view the verifier will 
automatically recognise the codes present.

Each symbol that is recognised as a barcode will be surrounded by a purple or blue 
box. The blue box indicates which symbol’s results are being shown on the right 
hand side of the Axicon Camera Verifier window. To change to the other barcode, 
click on the purple box, which will now become blue.

The results for this barcode are now shown in the window.
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A verification report may be saved in .csv, .pdf, .html or .txt formats. Additionally 
reports can be manually saved for subsequent printing or else printed without 
saving.

Use the File tab from the pull-down menu and then select Save Report.
Options will then be given for the various report saving options and you can then 
select between these as required.

If you want the report to be automatically opened on creation (for example, if 
there is a need to print the report) then tick the open report box.

For some file types you may wish to save data to a single file and append the data 
rather than replacing the previous data – for example when saving data to a .csv 
file.

In this case the Append Report box should be ticked. If this is left unticked and the 
same file name as previous is specified then the data will be overwritten.

After a successful decode of a barcode, the results can be saved to a file in special 
form of .png format). This is done by using the File/Save as function. These results 
can be reviewed at some later stage and shared with others. 

When a saved scan is opened by the application, the original data is available and 
displayed. In addition, the original image can also be re-verified using the verify 
button – this will then automatically use any plugins that are activated (such as CIP 
or serialisation validation) regardless of whether the plugins were used at the time 
of original verification.

To open a saved scan, use the File option from the pull-down menu and then 
select Load Scan. Select the file to be viewed and re-verified. The .png file is then 
displayed in the viewing area. The user should then press the Verify button.

The full verification information is then shown and can be viewed (and additionally 
printed) as required.

Saving and printing Disclaimer
In the following the expression verifier means the verifier hardware and the 
associated software.

We have taken care to ensure that this Verifier is free from defects. However since 
we have no control over the circumstances in which you might use the Verifier, 
you must satisfy yourself that the performance of the Verifier is suitable for your 
needs. Neither Axicon Auto ID Limited nor the vendor of this Verifier can accept any 
liability for any loss or damage (consequential or otherwise) which may be caused 
by use of this Verifier. 

If the Verifier or any part of it is defective in any way, or in some other way does 
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the 
cost of the product. You should bear this limitation in mind if you use this Verifier 
in any situations where the acceptance or rejection of shipments of goods or your 
reputation may depend upon the quality of a barcode.
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Software licence agreement
This software is Copyright © 2014 - 2016
Use of the software is subject to the Axicon software licence terms set out below. 
Using the software indicates your acceptance of these licence terms. If you do not 
accept these within 14 days, you may return the entire unused product for a full 
refund. 

Axicon grants you a licence to use any number of copies of the software, but only 
for use with an Axicon verifier. “Use” means storing, loading, installing, executing 
or displaying the software. You may not modify the software or disable any of its 
licensing or control features.

Ownership
The software is owned and copyrighted by Axicon Auto ID Limited. Your licence 
confers no title or ownership in the software and is not a sale of rights in the 
software.

Copies
You may only make copies of the software for archival purposes or when copying is 
an essential step in its use. You must reproduce all copyright notices in the original 
software on all copies. You may not copy the software onto a bulletin board or 
similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent 
from Axicon.

Transfer
Your licence will automatically terminate upon any transfer of the software. 
Upon transfer, you must deliver the software, including any copies and related 
documentation, to the transferee. The transferee must accept these licence terms 
as a condition of the transfer.

Termination
Axicon may terminate your licence upon notice of failure to comply with any 
of these terms. Upon termination, you must immediately destroy the software, 
together with all copies, adaptations and merged portions in any form.

Export requirements
You may not export or re-export the software in contravention of any applicable 
laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER 
In the following the expression “verifier” means the verifier hardware and the 
associated software.
 
We have taken care to ensure that this verifier is free from defects. However since 
we have no control over the circumstances in which you might use it you must 
satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited 
nor the vendor of this verifier can accept any liability for any loss or damage 
(consequential or otherwise) which may be caused by its use. 

If the verifier or any part of it is defective in any way, or in some other way does 
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the 
cost of the product. You should bear this limitation in mind if you use this verifier 
in any situations where the acceptance or rejection of shipments of goods or your 
reputation may depend upon the quality of a barcode.
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Warranty
Axicon 15000 verifier is sold with a two year parts and labour warranty against 
manufacturing defects. This is a return to bench warranty with shipping costs in one 
direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate 
packaging) must be used. If the equipment is returned without the original case, we 
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard 
warranty does not include the provision of a loan unit. Loan units can be supplied 
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned 
under warranty for which no fault is found. Please contact us to obtain an RMA 
number before returning any equipment. This number must be quoted on all 
documentation. We cannot accept responsibility for equipment returned without an 
RMA number.

Maintenance agreement
A service contract may be purchased within 30 days from the date of despatch. This 
allows you to return your verifier back to us at no extra cost for its annual VCAS 
(verifier calibration and alignment service) so that you can be sure it still measures 
barcode quality in accordance with the requirements of ISO/IEC 15426-1 and
ISO/IEC 15426-2

The service contract will also extend the warranty beyond two years, so that if it 
breaks down, all parts and labour will be provided free of any extra charges. The 
only exception is when the verifier has been misused, in which case labour costs 
will be covered, but not those of the parts.
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Factory re-calibration
All verifiers need servicing every year to ensure that they measure barcode quality 
in accordance with the relevant ISO/IEC standards. This verifier calibration and 
alignment service (VCAS) ensures that the verifier is internally dust-free, checks 
that it is focused correctly, and re-calibrates the hardware to account for any 
change in the brightness of the LEDs used to illuminate the barcodes.

This factory re-calibration is not the same as user calibration, as it looks at the 
output of the LEDs and corrects for any variance in their evenness of illumination 
across the whole field of view. Over time the LEDs will fade but they will not 
fade uniformly. User calibration ensures that the verifier is measuring the darkest 
and brightest reflectances correctly but it cannot correct for any variance in the 
illumination.

After your verifier has been serviced, we will return it you with the latest version 
of the software on CD together with a new calibration sheet, and a new user guide 
that will include the new certificate of ISO/IEC conformance. The latest software 
can always be downloaded free of charge from our website, www.axicon.com.

To arrange for your verifier to be serviced:

1. Contact us on 
 Telephone: +44 (0) 1869 351155 | Fax +44 (0) 1869 352404 
 Email: vcas@axicon.com
2. We will provide you with an RMA number (Return to Manufacturer Authority)  
 and an RMA form.
3. Please fill in all details requested on the RMA form, including the RMA number.
4. Return the verifier (including all cables) in its original case with the completed  
 RMA form, purchase order and your payment details to us at Axicon Auto ID  
 Ltd, Church Road, Weston on the Green, Oxfordshire OX25 3QP. We cannot take  
 responsibility for units returned in alternative packaging.
5. We will normally complete the service and re-calibration of your verifier within  
 7-10 days.

Certificate of ISO/IEC 
conformance

We, Axicon Auto ID Limited, of Church Road, Weston on the Green, Oxfordshire, 
OX25 3QP, UK, hereby declare, that the following barcode verifier(s):

Model number(s)

Serial number(s)

has been designed and manufactured at our address in the UK to verify barcode 
quality and to conform to: ISO/IEC 15426-1 and ISO/IEC 15426-2 barcode verifier 
conformance specification.

The equipment has been tested and calibrated using primary reference test 
symbols traceable to the USA’s National Institute of Standards and Technology’s 
reflectance standards. We also state that this equipment, when used with the 
latest verifier software, and configured appropriately has the features to meet 
the requirements of the United States Food and Drug Administration regulation, 
Title 21 CFR Part 11.

This verifier has been quality assurance checked today, and conforms to this 
ISO/IEC standard. This declaration of conformity is valid for a year.

Issue date

Expiry date

Authorised signatory

Signatory Name

At or before the expiry date the verifier should be returned to Axicon for its 
annual servicing and factory re-calibration. This VCAS (verifier calibration and 
alignment service) will ensure that the verifier remains conformant to ISO/IEC 
15426-1 and ISO/IEC 15426-2 for another year.

Church Road, Weston on the Green, 
Oxfordshire, OX25 3QP, UK
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Contact us
Axicon Auto ID Ltd 
Church Road, 
Weston on the Green, 
Oxfordshire 
OX25 3QP, 
UK

Tel:  +44 (0) 1869 351 155
Fax:  +44 (0) 1869 351 205
Email:  info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are 
subject to change without notice. All trademarks are acknowledged as belonging to 
their respective companies.

Your Axicon distributor


